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  1                                 اي افزار رایانه دستی و نرم (GPS)اس پییابی با جی مساحت

 

  مقدمه  -1
از سـوي فراگیـران مطـرح     دستی (GPS)جی پی اس  هاي آموزش که در دوره السؤ یک

چگونـه بـا   «: این است که ،دارند که یک پاسخ قطعی به آنان ارائه شودگردد و غالباً اصرار  می
گاهی از   »گیري کنیم؟ دستی، مساحت یک مزرعه یا یک قطعه زمین را اندازه جی پی اس

مـورد  گاهی نیـز اصـل قضـیه را    . نمایند یابی پرس و جو می در مساحت محتملخطاي  مقدار
  » ؟است امکان پذیردستی  GPSآیا تعیین مساحت با «: دهند ال قرار میسؤ

وزارت جهـاد کشـاورزي در اختیـار    هـاي   مجموعـه دستی که در  هايجی پی اس با 
سـنادي داشـته   ثبتی و یـا ا  اعتبارکه  با دقتیتوان مساحت را  نمیکارشناسان قرار دارد، 

 GPS ،یـابی  براي مسـاحت   قابل دسترسولی از آنجا که فعلاً ابزار  .گیري کرد اندازهباشد 
تـا حـد    را هـا خطاتوانیم  می، د شدکه در این نوشتار عرضه خواه مطالبیبا دستی است، 

 البته باید توجـه داشـت کـه   . کاهش دهیمرا با دنیاي واقعی ها  تفاوتاصلاح کنیم و  زیاد
    .دندستی ارزش ثبتی ندار هاي -GPS از به دست آمده هم نتایج پس از آن

و ، دادگسـتري، کارشناسـان امـور اراضـی    رسـمی  اعـم از کارشناسـان    GPSکاربران 
بنـابراین  . و یک دغدغه شغلی براي آنان اسـت  سر و کار دارند یابی مساحتبا  ،محققان

وجـود دارد آشـنا شـوند و     زمینـه اي کـه در ایـن    ضروري است کـه بـا خطاهـاي بـالقوه    
  .خطاهاي محاسباتی را تمرین نمایند کاهش هاي شیوه

ذیـل   مباحثتر به  تر و تا حد امکان کاربردي چه خلاصه داریم هردر این نوشتار قصد 
  :بپردازیم
را که  GARMINخانواده  GPSیک محدوده بوسیله  گیري مساحت اندازه روش .1
GPS مرور نماییم ،سازمانی در وزارت جهاد کشاورزي است. 
بررسـی   کمکیرا با استفاده از چند نرم افزار  GPSدستگاه  با برداشتخطاهاي  .2

 .نماییم
 قبولو قابل  تا حد نسبتاً مطلوببا دنیاي واقعی، ویرایش و  با مقایسهخطاها را  .3

  .اصلاح کنیم
 eTrex 10  در مدل. است eTrex 30مدل جی پی اس هاي ارائه شده، مربوط به  شکل

   .ها، گر چه با شکل و شمایل متفاوت، وجود دارند نیز تقریباً همین پنجره eTrex 20و 
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شـود، بخصـوص اگـر در     ها و عناوین متعـددي را شـامل مـی    فصل سر GPSآموزش 
اما بنابه اختصار که بایـد در تهیـه و تـدوین نشـریات     . باشدافزارهاي جانبی ارتباط با نرم

ایـن   بـر همچنین فـرض  . ایم بسنده نمودهرعایت گردد، تنها به طرح یک موضوع چالشی 
  .آشنایی دارند GPSبرد است که خوانندگان محترم به اصول کار

  

  افزارهاي کمکینرم -2
تعداد . است GPSکاهش خطاي کمک به ، جانبینرم افزارهاي برخی هدف از معرفی 

بـه مقصـود   را مـا  هـاي ذیـل   افزارنـرم د ولـی  افزار براي این منظـور وجـود دار  منرزیادي 
  :زیرا ،رسانند می

 ِآشنا با  به عنوان کاربرGPS ایم افزارها کار کردهبا این نرم . 
 دباش این نرم افزارها در دسترس میجدید   نسخه. 

 
 GPS خطايِ افزارهاي کمکی براي کاهشِمعرفی نرم - 1جدول 

  نرم افزار  ١لینک دانلودافزار و معرفی نرم

  .شود عرضه می GPS دستگاهنرم افزاري که همراه با 
  :لینک دانلود

http://www8.garmin.com/support/download_details.jsp?id=209 
Map Source 

  . Trackبه  Routeبراي تبدیل فایل نرم افزاري 
  :لینک دانلود

www.sackman.info 
WinGDB3 

  GPS  ٢براي بروز رسانی نرم افزار داخلی گیرنده نرم افزار
  :لینک دانلود

http://software.garmin.com/en-US/express.html 
Garmin Express 

   .یابی مفید است براي مساحت. MapSourceشبیه . با کامپیوتر GPSافزاري براي ارتباط نرم
  :لینک دانلود

http://www.gep.frec.vt.edu/cooltools.html 
GPS Utility 

ان به این نـرم  تو را می GPSهاي برداشت شده با  داده. کاربران با آن آشنا هستند نرم افزاري که
  :لینک دانلود. روي سطح زمین مشاهده کرد و آنها راافزار منتقل نمود 

https://support.google.com/earth/answer/168344?hl=en 
Google Earth 

                                                             
 .این نرم افزارها در یک لوح فشرده ضمیمه نشریه است تر البته قدیمی هاي رایگان و نسخه  -١
همواره به این که این ضرورت دارد  بنابر. است آن، عدم بروز رسانی نرم افزار GPS علل خطا و کاهش دقت دریکی از  - ٢

  .در فواصل زمانی معین، نرم افزار گیرنده را بروز رسانی نماییدو  نکته توجه داشت
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  یابی مساحت -3
 مثلاً یک(مشخص گیري مساحت یک محدوده  ، اندازهیابی مساحت در اینجا منظور از

گـارمین   گـروه از  GPSهاي مختلف  مدل .است GPSبوسیله دستگاه  )قطعه زمین زراعی
یابی دارند و بـا جسـتجو در    براي مساحتاي  گزینه ،GARMIN eTrex 30از جمله مدل 

  .دستگاه، یافت خواهد شداصلی منوي 
  

  یابی در مساحتمنابع خطا  -3-1
 قـرار داده شـده اسـت   یـابی   اي براي مساحت گزینههاي دستی  جی پی اس در اگر چه
اي  وسـیله  GPSبـه عبـارت واضـحتر،    . ندنیست ١براي مساحیمطمئن اي  وسیلهولی فعلاً 

اي که شـرکت   نکته .خطا دارد GPS: در یک جمله. ثبتی و ملکی نیست براي تعیین مرز
   .کرده استنیز به آن اشاره  دستگاه سازنده

محاسـبه  هاي دستی  و یا سایر مدل Garmin eTrexهاي مدل  مساحتی که با گیرنده
عوامـل  از  اي این تخمین بـر اسـاس مجموعـه   . است نه بیشتر تخمیند، فقط یک شو می

بـه دلیـل    ینابنـابر . دارنـد  ٢مند نظامشود که خطاي  برآورد میافزاري  افزاري و نرم سخت
؛ مگـر  نـداریم گیري اطلاع  مقدار واقعی خطاي اندازهبودن خطاهاي برداشت، از مند  نظام

 GPSاسـتفاده از   دیگـر  ،هـاي دیگـر اسـتفاده کنـیم کـه در ایـن صـورت        اینکه از روش
  !موضوعیت ندارد

  :٣گیرند گروه قرار میدر سه  یابی مساحت منابع خطا در
 خطاي کاربر  GPS  
  دستگاه خطاي GPS  
  عوارض جغرافیايخطاي مربوط به 

  

                                                             
1 - Surveying 
2 - Systematic 

 .وار اشاره شده است یش از این است که در اینجا فهرستمنابع خطا و علل آنها ب - ٣
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  GPSبرخی خطاهاي کاربر  -3-1-1
منتظـر  دو دقیقـه  حداقل  بایدمعمولاً  .دستگاه به طور صحیحنکردنِ راه اندازي  - 1

  .تا دستگاه به حالت پایدار برسد که بتواند موقعیت یک نقطه را تعیین کند بمانیم
 .سالمهاي نا ستگاه و استفاده از باطرياز د نکردنمراقبت  - 2

  .یابی در موقع مساحت سرعت زیاد - 3

  
  GPS دستگاه برخی خطاهاي  -3-1-2

  . GPSدر ارتباط با گیرنده  هايِ ماهوارهکم تعداد  - 1
هاي  بِ تنظیمات دستگاه، برخی از گوشهممکن است بر حس. تنظیمات دستگاه - 2

قطعات و ، بخصوص در این ایراد. زمین حذف شوند و لذا از دقت محاسبات کاسته شود
 .دهد بیشتر خود را نشان می ،شکل نامنظم دارايکوچک و یا  هاي زمین

 
  :1 یادآوري

نامنظم، بهتر است دسـتگاه را طـوري    هاي با شکل زمینهاي کوچک و  براي مساحت
این هدف وارد منـوي   براي. را حذف نکند ي زمینها تنظیم کنید که تا حد ممکن گوشه

  :اصلی شوید
Main Menu > Setup > Tracks  

و  Record Method چهار گزینه موجود، دو گزینۀاز بین شود  اي که باز می در پنجره
Recording Interval  تغییـر هـر گزینـه باعـث     . تنظیم کنیـد را به یکی از سه حالت زیر

  .)پ -1الف تا  -1هاي  شکل(شود  گزینه دیگر میهاي  انتخاب در تغییر
  

  

 حالت سوم  حالت دوم  حالت اول  گزینه ها
Record Method: Distance Time Auto 
Recording Interval: 0.01km 00:00:05 Most Often 
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 Recordبهتر است گزینـۀ  Tracksیعنی در پنجره  .ددار بیشتري حالت سوم اولویت

Method در وضعیت Auto  گزینـه   باشـد و قرار داشتهRecording Interval روي Most 

Often باشد.  
  
  
 
 

 
 
 

 
 

  عوارضبرخی منابع خطاي جغرافیاي  -3-1-3
هـاي   زمـین بـه مسـتطیل   شکل چه  در مقایسه با شکل مربعی، هر. شکل زمین - 1

 .است، خطا بیشتر دطویل نزدیکتر باش
 ....هاي تند و  مانند کوه، تپه، شیب .موانع طبیعی - 2
 ...و  یهاي فشار قوي و مخابرات مانند دکل. سیساتتأ - 3

  
  دستی GPSبا  یابی هاي مساحت روش -4

   :شود کلّی انجام میروش دو دستی به  GPSیابی بوسیله  مساحت
  از استفاده روشTrack ) گزینهArea Calculation( 
  استفاده از روشRoute 
 

  GPSاصطلاح در  چند
Track  پایا وقتی که روي محیط یا روي اضـلاع یـک قطعـه     ):مسافت پیموده شده( رد

هـاي   هایی را با فاصله پیمایید، نقطه مسیري که شما می در GPS  کنید، گیرنده زمین حرکت می
ایـن نقـاط بوسـیله    . گوینـد  مـی  track pointکه بـه آنهـا    کند می ثبت در حافظه دستگاه معین
 trackهـا   ها و خـط  نقطهاین به مجموعه . track logبه نام  شوند هایی به یکدیگر متصل می خط

 پ - 1شکل  ب - 1شکل  الف - 1شکل 
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یـا   »رد پـا «اصـطلاحِ  ان هم ـ GPSدر دستگاه  trackتوان گفت منظور از  میبنابراین . گویند می
  .است مسافت پیموده شده

Route  در دستگاه  :مسیریاGPS پا، مسیر هم مانند نقطـه و خـط تشـکیل     ياز تعداد رد
به طور خودکار پیمودنِ یک مسافت  پس از رد پااین است که  رد پا وت مسیر تفا اما. شده است

طراحـی   GPSدر دسـتگاه  یـک هـدف   بر اسـاس  شود ولی مسیر را  ایجاد میدر حافظه دستگاه 
سازیم تـا   می GPSاما مسیر را در  شود می ساخته رد پا یم،کن می مسافتی را طیوقتی . مکنی می

مسـیر در   .گیـري کنـیم   پیماییم و یا یک مساحت را اندازهیک مسیر معین را ب ،با استفاده از آن
  . خواهید مساحت آنرا محاسبه کنید واقع مرز زمین مورد نظر شما است که می

Waypoint  در  :نقطهیاGPS کنیم و یا دستگاه  نقاطی که مختصات آنها را برداشت می، به
 Waypoint کنـد  مسـیر آنهـا را ایجـاد مـی    موجود در هاي  در حین حرکت براي ثبت شکستگی

   .شود گفته می
  
   Area Calculationگزینه  یابی با مساحت: روش اول -4-1

 .را روشن کنید GPSدستگاه  .1
 .راه اندازي شودبطور صحیح صبر کنید تا دستگاه  .2
هـا از  رد پاپاك کـردن  . پاك کنیدرا  وجود دارند GPSیی که از قبل در هارد پا .3

 یـابی  قبـل از مسـاحت   هـا را رد پاالزامی نیست ولی حداقل بهتر است که  GPS حافظه
  .را از دستگاه پاك کنید هاو سپس آثار آنکنید ذخیره 

  :2یادآوري 
 ) پ -2الف تا  -2هاي  شکل( :را پاك کنید رد پادستور زیر، از 

Main Menu > Track Manager > Current Track > Clear Current Track 
 

 

  
  
  

 

 پ -2شکل  ب -2شکل  الف -2شکل 
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 . کلیک کنید Area Calculationروي  منوي اصلیدر  .4
و شـروع بـه حرکـت     کلیـک کنیـد  را  Startدکمـه   بایسـتید و  زمـین  مرزروي  .5

اگر در حین حرکـت بـه دلیـل وجـود عوارضـی ماننـد درختـان یـا          .نمایید) پیمایش(
 ،موقتاً قطع شد، نگران نباشید چون گیرنـده ها  دستگاه با ماهواره ارتباط ...ساختمان و 

 .کند فاصله بین نقاط را تکمیل می
 گزینـه ، برگشـتید حرکـت  شـروع  بـه نقطـه   محیط زمین را طی کردید و وقتی  .6

Calculate  پ -3الف تا  -3هاي  شکل( .نمایش داده شودتا مساحت محدوده  بزنیدرا( 
 
  
  
  
  
  
  
  
  

را فشـار   Calculateحرکت برسید، دکمـه  شروع قبل از اینکه به نقطه سهواً اگر  .7
 ازیعنـی  بنـدد،   بطور خودکار محدوده را با یک خط مسـتقیم مـی   GPSگیرنده دهید، 

البتـه  . کنـد  کامـل مـی   ،را با یک خط مسـتقیم  حرکت تا نقطه شروعِجایی که هستید 
 .خطا شود موجبممکن است 

 را ذخیـره کنیـد   رد پـا ، Save Track، با گزینـه  زمین مساحت اطلاع ازپس از  .8
رد پاي ذخیره شده را مطـابق   بعداً توانید به دلیل اینکه می) ث -3و  ت -3هاي  شکل(

بصـورت چشـمی بررسـی کنیـد و در      بیان شـده اسـت،   4-3قسمت که در روش دوم 
 .خطاها را اصلاح نمایید ،ضرورتصورت 

  
  
  

 

 ث - 3 شکل ت - 3شکل 

 پ - 3شکل  ب - 3 شکل الف - 3شکل 
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 :شده را به نمایش در آورید رد پاي ذخیره با دستور زیر
Main Menu > Track Manager > Archived Tracks 

موقعی که در حال پیمایش روي محیط زمین هستید، هر چه به نقطۀ تغییر : 1نکته 
زیـرا اگـر   . شوید، از سرعت خود بکاهید تا خطاي دستگاه کمتـر شـود   جهت نزدیکتر می

دهـد و ایـن    دستگاه هنوز پیمایش را ادامه مـی ناگهان توقف کنید یا تغییر جهت دهید، 
  .شود سبب خطا در ترسیم شکل زمین می

 

   Routeاستفاده از  یابی با مساحت: روش دوم -4-2
  Routeهاي روش استفاده از  یتمز -4-2-1

محـیط  (اضلاع محـدوده مـورد نظـر     که در امتداد نیستیددر این روش مجبور  .1
. حرکـت کنیـد   زمـین به عبارت دیگر لازم نیسـت روي مـرز   . قدم پیمایی کنید) زمین
  .کند کفایت می زمینهاي  گوشهزدن در  GPSفقط 
موجـب   جغرافیـایی هاي بزرگ و یا مناطقی که عوارض  این روش براي مساحت .2

وجـود  به دلیل اگر مثلاً  .را پیمایش کنید مناسب است زمینشوند تا نتوانید محیط  می
بهتر  توانید محیط زمین را طی کنید نمی در قسمتی از مسیر پیمایش مرداب یا پرتگاه

  .است از این روش استفاده نمایید
 GPSدر  Route ساختن مراحل -4-2-2

 .دستگاه را روشن کنید .1

 . صبر کنید تا دستگاه راه اندازي شود .2

3. پاك کنیدزیر،  با دستوررا پاها  رد: 
Main Menu > Track Manager > Current Track > Clear Current Track 

 3و  2و  1نقاط برداشت شده را با اعـداد  . بزنید GPS، ي زمینها در تمام گوشه .4
 .١بترتیب نامگذاري کنید... و 

 :زیر شوید پنجرهوارد در منوي اصلی  .5
                                                             

 Google، از کاغذي معتبرنقاط مورد استفاده براي ساختن مسیر را از نقشه مختصات جغرافیایی توانید  می حتی -  ١
Map یا وGoogle Earth  استخراج کنید.  
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Main Menu > Route Planner 
 .را انتخاب کنید Create Routeگزینه  .6

 )پ -4الف تا  -4هاي  شکل(را انتخاب کنید  Select First Point گزینه  .7
 

  
  
  
  
  
  

 .را انتخاب کنیدWaypoints گزینه  .8

  .واهید کردرا مشاهده خ GPSذخیره شده در یک فهرست از نقاط  .9

 )ج - 4تا  ت - 4هاي  شکل( .کنید کلیکرا  Useرا انتخاب و گزینه  1نقطه شماره  .10
 

  
  
  
  

  
 
  

 Selectبا گزینه  .کنید مسیروارد را تکرار کنید و بقیه نقاط را  10و  9مراحل  .11

Next Point ) چ -4شکل( 
 

 ج -4شکل  ث -4 شکل ت -4شکل 

 پ -4شکل  ب -4 شکل الف -4شکل 
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بـه  روي دسـتگاه،   backبـا دکمـه    ،کردیـد  مسیروارد  را نقاطوقتی که همه  .12
 :منوي زیر برگردید

Main Menu > Route Planner 

بـا   .کنید اید مشاهده می که ساختهرا مسیري اسم  Route Planner صفحۀدر  .13
نقـاطی را  اگر نیاز بود مثلاً . توانید آنرا ویرایش کنید اید می که ساخته مسیريانتخاب 

 )خ -4 و ح -4هاي  شکل( .اضافه یا حذف کنید

 
 
 
  
  
  
  
  

 براي محاسبه مساحت GPS Utility به Route انتقال -4-2-3

  .را باز کنید GPS Utilityنرم افزار   .1

  .را باز کنید) یدا همسیري که ساخت( Routeفایل  …File > Open با دستور  .2

 را مشـاهده کنیـد   مسـیر  توانیـد نقشـۀ   مـی  View > Mapدسـتور  اجراي با   .3
 .)5شکل (

 چ -4شکل 

 خ -4 شکل ح -4شکل 
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  GPS Utilityمشاهده مرز زمین در نرم افزار  -5شکل 
 

بـاز  GPS Utility Reports  بـه نـام   پنجـره یـک   View > Reports دسـتورِ  بـا  .4
 ).6شکل (شود  می

، یک نرم افزار رایگان از شرکت گارمین استنیز که  BaseCamp نرم افزار :2نکته 
  : لینک دانلود .تواند براي مشاهده و محاسبه مساحت زمین، مورد استفاده قرار گیرد می

http://www.garmin.com/basecamp 
  

  
 GPS Utilityصفحۀ گزارش در نرم افزار  -6شکل 
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، مطـابق  در این مثال. شده است ثبتدر سطر آخر، مساحت زمین  ،در صفحۀ گزارش
  .هکتار است 736/25922برابر  ،ود، مساحت زمینش مشاهده می 6آنچه در شکل 

  یـک نقطـه  تـوانیم محـل    یعنی مـی  ،داردوجود ویرایش  امکانِ GPS Utilityنرم افزار در 
مـورد   زمینِقطعه ویرایش شکلِ به منظورِ (نقطه  یکبراي تغییر محلِ  .دهیم تغییررا  دلخواه

خواهیـد آن را اصـلاح    کـه مـی  ) شکسـتگی (= گوشه از نقشه  یکروي  Map صفحۀدر ، )نظر
  . ماوس را رها کنیدسپس و  (drag) ببریددلخواه  محلِکنید، کلیک راست را نگه دارید و به 

 
  اي برداشت نقطه افزایش دقت -5

گزینـه فـوق   . قرار داده شده اسـت  Waypoint Averaging  گزینه eTrex30در مدل 
بـدین  . بـا دقـت بیشـتري ثبـت شـود      ،سازد تا مختصات هر نقطه این امکان را فراهم می

  .کند محاسبه می» یک مختصات میانگین«طی چند مرحله متوالی، ترتیب که 
 :را بدست آورید» مختصات میانگین«به روش زیر توانید  می

  :زیر را اجرا کنید دستور -الف
Main Menu > Waypoint Manager  

  .را فشار دهید GPSروي دستگاه  back کلید -ب
 - 7هـاي   شـکل ( یک نقطه را انتخاب کنیـد ، GPSنقاط داخل فهرست بینِ از  
  ).پ - 7تا الف 

  

  
  
  
  
  
  
  
را  GPSروي دسـتگاه   menu کلیـد . شـود  صفحه مشخصات آن نقطه ظاهر می -ت

  .باز شود پنجرهبزنید تا یک 

 پ -7شکل  ب -7 شکل الف -7شکل 
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 پنجره جدیـد تا یک  را انتخاب کنید Average Locationگزینه در این پنجره،  -ج
 ).ج -7ت تا  -7هاي  شکل( را بزنید Start گزینه .باز شود

  
  
  
  
  
  
  

رسـید،   %100کامـل شـد و بـه     Sample Confidence سبز رنگ وقتی که نوارِ -ح
  ).خ -7تا  چ -7هاي  شکل(را فشار دهید  Done گزینهو سپس  Save گزینهابتدا 

  
  
  
  
  
  
  

  
حـداقل  فاصـله  و  تکرار کنید نقطه مورد نظرهر  برايمرتبه  8تا  4بین این مراحل را 

  . نماییدرعایت  هاي متوالی را دقیقه بینِ برداشت 90
  

  Google Earth Proافزار یابی در نرم مساحت -6
در این صورت باشد،  مشاهدهوي گوگل ارث قابل کاربري، رمزرعه یا اگر مرز زمین یا 

و سـریع و  دستی، همراه با مشاهده چشـمی،   GPSرا با دقتی بیش از توانیم مساحت  می
اگر مدتی طولانی از تاریخِ بروز رسانی تصـویرِ آن   براي برخی مناطق .تخمین بزنیمآسان 

ولـی همـین اشـکال     ممکن موجب خطا شـود  ،مناطق توسط شرکت گوگل گذشته باشد

 خ -7 شکل ح -7 شکل چ -7شکل 

 ج -7 شکل ث -7 شکل ت -7شکل 
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  .پیگیري شود Historyنیز قابل بررسی است و باید با استفاده از گزینه 
  . را باز کنید Google Earth Proنرم افزار  -1
  )8شکل ( .پیدا کنیدروي نقشه مورد نظر را  کاربريمحل  -2
  .باز شود Rulerکلیک کنید تا پنجره  Show Ruler گزینه رويدر نوار ابزار  -3

  

  
  
  

 
 
 
 
 

  تعیین محل زمین در گوگل ارث - 8شکل 
بـه  در این حالت با ماوس که را انتخاب کنید و  Polygonزبانه  Rulerدر پنجره  -4
ترسـیم  را شـکل زمـین    وزمین کلیـک کنیـد    هاي گوشهدر شود،  تبدیل میمربع یک 
 )9شکل ( .کنید
  

  
  
  
  

  
  
  

  رسم کروکی در گوگل ارث - 9شکل 
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 51/3در ایـن مثـال برابـر    . مشـاهده کنیـد   Rulerدر پنجـره  مساحت زمین را  -5
  )9شکل ( .هکتار است

هـاي   مـورد نظـر خـود، در سـال     منطقهبراي مشاهده تصاویر  Historyاز گزینه  :3 نکته
ها و یا تغییـر مـرز زمـین در طـول      این گزینه براي بررسی تغییر کاربري. استفاده نماییدقبل 

  .زمان مفید است
و  MapSourceبهتـر از   Google Earthدر   GPSهـاي  مشـاهده برداشـت   :4نکتـه  

GPS Utility تـوانیم دربـاره تفـاوت     اي مـی  زیرا در گوگل ارث، روي تصویر ماهواره است
همیشـه  . بـا دنیـاي واقعـی قضـاوت کنـیم     ) رسـم شـده اسـت    GPSکه با (حدود زمین 

  .را در گوگل ارث مورد بررسی قرار دهید GPSهاي  داده
  

  MapSourceنرم افزار  به کمکیابی  مساحت -7
بـا کـامپیوتر ارائـه     GPSتوسط شرکت گارمین بـراي ارتبـاط    MapSource نرم افزار

بـراي تعیـین    .اسـت  GPSکـاربران   بـراي ترین نرم افـزار  این نرم افزار معروف. شده است
  :مساحت یک زمین با این نرم افزار، با دو وضعیت روبرو هستیم

  وضعیتی که بوسیلهGPS   کروکی زمین را بصـورتTrack   کنـیم   برداشـت مـی
بــاز  MapSourceرا در  Track، و ســپس )شــرح دادیــم 4-2مثــل آنچــه در قســمت (

  .نماییم می
 رت یـک مسـیر   زمـین را بصـو   کروکیتی که وضعی(Route)   در دسـتگاهGPS 

 .کنیم منتقل می MapSourceبه  و) مراجعه کنید 4-3به قسمت (سازیم  می
 

  MapSourceدر  Trackبا استفاده از  یابیمساحت -7-1
 قبلاًکند که  شرطی مساحت را به طور خودکار محاسبه میه ب MapSourceنرم افزار 

به قسـمت  ( کرده باشیمذخیره  GPSدر دستگاه  Trackبصورت را مرز یا محدوده زمین 
  :اگر این کار انجام شده باشد. )رجوع کنید 10 ، صفحه8بند  2-4

  .را اجرا کنید MapSourceنرم افزار  -1
2- پا فایل رد(Track)  را درMapSource 10شکل ( باز کنید( .  
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را بـه کـامپیوتر وصـل     GPSتوانیـد   می، GPSاز داخل  Trackبراي باز کردن  :5 نکته
هـارد  را روي  Track فایـلِ  ابتـدا اینکـه  فایل را بـاز کنیـد، و یـا     GPSکرده و از درایو 
   .آنرا باز کنید سپس وکامپیوتر کپی 

  

  
  MapSourceدر  Trackمشاهده  - 10شکل 

  

  .)11شکل ( باز شود Track Propertiesدابل کلیک کنید تا  Trackروي اسم  -3
  
  
  
  
  
  
  
  

  
  )متر مربع  5878برابر (مشاهده مساحت زمین  -11شکل 
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. شـود  مساحت زمین مشاهده می Areaدر ستون  Track Propertiesدر پنجره  -4
  . متر مربع 5878در مثال فوق، مساحت زمین برابر است با 

کنـد   حتی اگر مرز زمین بسته نباشد، نرم افـزار، مسـاحت را محاسـبه مـی     :6 نکته
 .بندد محدوده را با یک خط راست میچون بطور خودکار 

  
 MapSourceدر  Routeبا استفاده از  یابیمساحت -7-2

افـزار  براي انجام تمرینات بیشتر در محیط نـرم  27مطالب این قسمت، تا آخر صفحه 
MapSource ملحقات  ازافزار به دلیل اینکه این نرم. استGPS    دستی گـارمین اسـت و

اما بجاي روشـی کـه در ادامـه    . آشنا باشد MapSourceافزار الزاماً باید با نرم GPSکاربر 
بـراي   GPS Utilityبـه   Routeانتقـال  « 4-3-3 توانید مطـابق قسـمت   شود می بیان می

  .عمل کنید] 14در صفحه [» محاسبه مساحت
  

افـزار  در نـرم آنـرا  بسـازیم و   Routeبه صورت  4-3کروکی زمین را مانند قسمت  اگر
MapSource در ایـن  . کنـد نمـی افزار بطور خودکـار مسـاحت را محاسـبه    باز کنیم، نرم

  :اطلاع از مساحت زمین دو انتخاب در اختیار داریمحل این مسئله و براي وضعیت 
-کنیم تـا نـرم   تبدیل   Trackبه WinGDB3افزار را با نرم Routeفایل  :انتخاب اول

بـراي تبـدیل   . خودکار مسـاحت زمـین را محاسـبه کنـد    بتواند بطور  MapSourceافزار 
Route  بهTrack افزارِ با استفاده از نرمWinGDB3  یر را انجام دهیدزمراحل:   
  .را اجرا کنید MapSourceافزار نرم -1
  ).12شکل ( باز کنید MapSourceدر را  Routeفایل  -2
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 MapSourceدر  Routeمشاهده  - 12شکل 

  
  .)13شکل ( ذخیره کنید gdb١را با فرمت  Routeفایل  -3

  

  
 gdbبا فرمت  Routeبراي ذخیره  MapSourceدر  Save Asپنجره  -13شکل 

  

  . را اجرا کنید WinGDB3نرم افزار  -4

                                                             
1 - Garmin GPS Database 
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 . معرفی کنیدرا  gdbفرمت  بافایل  ،Inputدر قسمت  -5
 .را انتخاب کنید MapSourceگزینه  Outputدر قسمت  -6
7-  در قســمتProcessing options  ــه شــماره ــد 12گزین  .12). را انتخــاب کنی

 Convert routes to tracks…) 
 .)14شکل ( را بزنید Convertدکمه  -8
  

  
  .و گزینه هایی که باید انتخاب شوند WinGDB3محیط نرم افزار  -14شکل 

  
تبـدیل   Trackبـه   Routeکردید و فایل را کلیک  Convertپس از اینکه دکمه  -9

  .)15شکل ( شود باز میبطور خودکار  MapSourceدر   Track، فایلشد
  

  
  MapSourceدر  Trackباز شدن  -15شکل 
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 Trackپنجـره  دابـل کلیـک کنیـد تـا     Trackروي اسـم   MapSourceدر محیط  - 10

Properties 16شکل ( باز شود(.  
  

  
 Track Propertiesمشاهده مقدار مساحت زمین در  -16شکل 

  
 26000(متر مربـع  کیلـو  260سـاحت زمـین برابـر اسـت بـا      در مثال فـوق، م  -11
در اینجا نیز اگر مـرز زمـین بسـته نباشـد، نـرم افـزار بطـور خودکـار         . باشد می) هکتار

  .کند بندد و مساحت را محاسبه می محدوده را با یک خط راست می
نقـاط را بـا    تعـداد روي محیط زمین مختصات یک  GPSابتدا با : پس بطور خلاصه

در  .بسـازید  Routeبـا اسـتفاده از ایـن نقـاط یـک      . شرایطی که گفته شـد ثبـت کنیـد   
MapSource  فایلRoute   را با فرمـتgdb    ذخیـره کنیـد(File/Save As…) .   فایـل بـا

 Trackسپس فایـل  . تبدیل کنید Trackبه  WinGDB3را به کمک نرم افزار  gdbفرمت 
  .باز کنید و مساحت آنرا مشاهده نمایید MapSourceرا دوباره در 

کپـی   از روي کروکـی زمـین   MapSourceبا ابزار موجود در نرم افزار  :انتخاب دوم
  .کنیم مشاهدهو مساحت آنرا کنیم برداري 
  .را اجرا کنید MapSourceنرم افزار  -1
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  .را باز کنید Routeفایل  -2
  .را انتخاب کنید Distance/Bearingگزینه  Toolsاز منوي  -3
کلیک کنیـد و بـا مـاوس روي اضـلاعِ      Waypointروي هر  ،مسیر روي خطوط -4

Route  یـک   کپـی بـرداري  شبیه (حرکت کنید تا شکل محدوده مورد نظر، کامل شود
در . از یک نقطه معین شروع کنید و به همـان نقطـه بازگردیـد   ). وطنقاشی از روي خط

  .شود میک کپی از کروکی زمین تهیه واقع ی
) ١پلیگـون (پس از کامل شدن شکل زمین و تشـکیل یـک چنـد ضـلعی بسـته       -5

در این مثال، مساحت محاسـبه  . شود می ظاهرمساحت محدودة بسته، در نوار وضعیت 
  .)17شکل ( باشد هکتار می 25977برابر با شده در 

  Status Barمشاهده مساحت زمین در - 17شکل 
  

 Google Earth Proدر  تصحیح شکل زمین -8

از مسـیر   GPSقبل از شروع پیمایش بر روي محیط زمین مورد نظر، بایـد در   :نکته
  .را پاك کنید Current Trackمناسب، 

. ایم کرده قدم پیمایی GPS ا، بمحدوده زمینمساحت یک  اطلاع ازفرض کنید براي 
ایم و دستگاه، محیط زمین را بصورت یـک   روي محیط زمین حرکت کرده GPSیعنی با 

                                                             
1- Polygon   
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Track خواهیم کروکـی زمـین را بـه منظـور بررسـی خطـاي        می. ایم کرده و ذخیره ثبت
بینی کنیم و در صورت وجود خطـا، آنهـا را    باز Google Earth Proدستگاه، در نرم افزار 

  .اصلاح یا ویراش نماییم
  .را اجرا کنید Google Earth Proنرم افزار  -1
بـاز   رایانـه و یـا از روي   GPSرا از داخل  Trackفایل  …File > Openاز مسیر  -2
  . کنید

  .شود هر سه گزیده را انتخاب کنید اي که باز می موقع باز شدن فایل در پنجره
را کلیــک کنیــد تــا  Temporary Placeدر کنــار  <هــاي  علامــت Sidebarدر  -3

  .محتویات آن را ببینید
ــون  Sidebarدر  -4 ــه   Pathروي آیک ــد و گزین ــک کنی ــت کلی را  Propertiesراس

شـود   اکنون ماوس به یک مربع تبـدیل مـی  . شود باز  Edit Pathانتخاب کنید تا پنجره 
ماوس را روي یک نقطه . کند قرار گیرد به یک دست تغییر میاي  که اگر روي هر نقطه

  .(drag)نگهدارید و آنرا به محل دیگر ببرید 

  .برداشت شده است  GPSمسافت طی شده که با -18شکل 
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راسـت کلیـک کنیـد و     Pathروي : پس از انجام تغییرات، فایل را ذخیره کنیـد  -5
Save Place As… . فایل با فرمتKMZ موقـع ذخیـره، تیـک کنـار     . شـود  ذخیره می

Points را بردارید.  

  .اصلاح شده است Google Earthکه در  Track - 19شکل 
  

6-  Google Earth Pro را ببندید .  
  :تبدیل کنید GPXرا به فرمت  KMZفرمت  -7

  

  . ExpertGPSبوسیله نرم افزار  GPXبه فرمت  KMZتبدیل فرمت  :روش اول
  .را باز کنید ExpertGPSافزار   نر -
  :از مسیر زیر باز کنیدرا  KMZفایل  -

 File>Import Data from Other Programs …  
روي یکی از  GPXبه فرمت  …File>Save Asفایل احضار شده را از مسیر  -

  .درایوهاي رایانه ذخیره کنید
  

در تبـدیل فرمـت را    Onlineبصـورت  هـا،   د با رعایت امنیت دادهتوانی می :روش دوم
   :براي این منظور .دهیدانجام  www.gpsvisualizer.comسایت 



 اي افزار رایانه دستی و نرم (GPS)اس پییابی با جی مساحت                                 24

 

  . )20شکل( شوید www.gpsvisualizer.comوارد سایت  -
  .را انتخاب کنید Convert to GPXگزینه  -

  .کنید را در سایت، بارگذاري KMZفایل  -
اي کـه بـاز    بعـد از تبـدیل فرمـت، در صـفحه    . را کلیک کنیـد  Convertگزینه  -

کلیک کنید تا فایـل حاصـل از تبـدیل فرمـت      …Click to downloadشود روي  می
  .دانلود شود

  GPXبه  KMZصفحه اي براي تبدیل فرمت   -20شکل 
  
12- Google Earth Pro  را باز کنید و فایلGPX در صورتی که نتیجـه  . را ببینید

را  Google Earth Proرا بررسی کردید و تایید نمودید که با واقعیـت همخـوانی دارد،   
  .ببندید
13- MapSource  را اجرا کنید و فایلGPX را باز کنید.  
شـود مسـاحت را    کـه بـاز مـی     اي روي اسم فایل دابل کلیک کنید و در پنجره -14
  .)21شکل ( ببینید
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  MapSourceمشاهده مساحت زمین در   - 21شکل 

 36/8معـادل  (متـر مربـع    83603مساحت قطعه زمـین زراعـی در ایـن مثـال برابـر      
  .می باشد) هکتار

  
 راهنماي موضوعی -9

و با توجه بـه  » ابزاري که در اختیار داریم«و » خصوصیات منطقۀ مطالعاتی«بسته به 
یـابی   ، از یـک روش مناسـب بـراي مسـاحت    »کنیم می یابی هدفی که براي آن مساحت«

  :استفاده کنید

  
 است؟  قابل مشاهدهگوگل ارث اي موجود در  ، روي تصویر ماهوارهآیا مرز زمین

 :1سوال

  .استفاده کنید Google Earth Proبراي مساحت یابی از 

  : به موضوعِ رجوع کنید

  ]19صفحه [» Google Earth Proیابی در نرم افزار  مساحت«
 :بلی

ولی با توجـه بـه پاسـخی کـه بـه سـوال بعـد         استفاده کنید GPSیابی از  براي مساحت
 :خیر  .را انتخاب کنید دهید، روش مناسب می
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یابی  براي مساحت GPSاز  صعب العبوریک منطقه منطقه وسیع یا براي یک آیا 
 :2سوال ؟کنید استفاده می

توانیـد   مـی . استفاده کنید GPSدر منوي اصلی دستگاه  Area Calculation دستوراز 
  :یکی از دو روش زیر را انتخاب کنید

اعتماد کرده و به عددي کـه   Area Calculation یا به نتیجه حاصل از دستور -1
  .کنید دهد، اکتفا کند و به شما ارائه می دستگاه محاسبه می

  :به موضوعِ رجوع کنید
  ]8صفحه [» Area Calculationیابی با  مساحت«

محاسـبه شـده اسـت،     Area Calculationیا پس از اطلاع از مساحتی کـه بـا    -2
ذخیـره   GPSرا در  یـابی  در عملیات مساحت (Track)خطوط مسافت پیموده شده 

 Trackتوانید  ، میMapSourceدر . باز کنید MapSourceسپس آنرا را در و کنید 
ــثلاً تصــحیح جابجــایی. را تصــحیح کنیــد را ببینیــد و خطاهــاي احتمــالی هــا و  م

  .... ها و  و یا حذف همپوشانی. دانیم چنین نیست ها در جاهایی که می شکستگی
  : موضوعِ رجوع کنید به

  ]21صفحه [» MapSource یابی به کمک نرم افزار مساحت«
  ]21صفحه [» MapSourceدر  Trackیابی با استفاده از  مساحت«

 :خیر

  . استفاده کنید Routeاز روش 
روي محیط زمین مورد نظر، مختصات یک سري نقاط را بـا شـرایطی کـه     GPSابتدا با 

را  Routeسپس فایـل   .بسازید Routeبا استفاده از این نقاط یک . گفته شد ثبت کنید
  .باز کنید و مساحت زمین را مشاهده نمایید GPS Utilityدر نرم افزار 

 : موضوعِ رجوع کنید به

  ]11صفحه [» Routeیابی با استفاده از  مساحت«
  ]14صفحه [ »براي محاسبه مساحت GPS Utilityبه  Routeانتقال فایل «

  :بلی
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 گیري نتیجه -10

  گیري مساحت اراضی خصوصـاً آنهـا کـه شـکل     دانیم که بهترین روش براي اندازه می
اما واقعیتی کـه  . است خاص هاينامنظم دارند، نقشه برداري با استفاده از دوربین و ابزار

یـابی اسـتفاده    دسـتی بـراي مسـاحت    GPSبینیم این است که بسیاري از کاربران، از  می
  . کنند می

فقـط در حـد   . یابی کرد توان بطور دقیق مساحت دستی نمی GPSباید بپذیریم که با 
ایی کـه  حتی نرم افزاره. توان از این وسیله اطلاعات کسب کنیم یک تخمین و تقریب می

هـایی کــه پیشـنهاد شـدند نیـز بـدون نقـص نیســتند و        از آنهـا نـام بـرده شـد و شـیوه     
  . هاي خاص خود را دارند محدودیت

یابی استفاده کنـیم،   اما اگر اصرار داریم و یا ناچاریم که از همین وسیله براي مساحت
ا بیابیم و تمرین هایی ر ها را بپذیریم و بسته به انتظاري که داریم، راه حل باید محدودیت

  .کنیم
یابی، ناشـی از عـدم اطـلاع ایشـان از      توسط همکاران براي مساحت GPSاستفاده از 

هاي روزانۀ صـحرایی   نیست، بلکه به این دلیل است که در مأموریت GPSخطاي دستگاه 
دستی بوده و براحتی قابل تهیـه و   GPSاي که دقیقتر از   هاي کشاورزي، وسیله در عرصه

  . جابجایی باشد، در اختیار نداریم
یابی از یک طـرف، و نیـاز    دستی براي مساحت GPSهاي  با در نظر گرفتنِ محدودیت

سریع از طرف دیگـر، از پـنج نـرم افـزار بـراي       با کاربردقابل حمل  وسیلۀکاربران به یک 
  . استفاده کردیم GPSخطاهاي دستگاه تصحیح 

توان خطاي دستگاه را تصـحیح کـرد ولـی مسـتلزم      هاي دیگري نیز می البته به روش
بـراي آنکـه   . اي است و استفاده از تصاویر ماهواره ArcGIS هایی مانندآشنایی با نرم افزار

و اسـتفاده   GISموجب تداخل موضوعات یا پراکندگی مطالب نشویم، از ورود به مباحث 
و بعضـاً جـایگزینی    GPSزاري براي تصـحیح خطـاي دسـتگاه    اي که اب از تصاویر ماهواره

هـایی   بنابراین براي حل ایـن معضـل بـه ارائـه شـیوه     . براي آن هستند خودداري نمودیم
  : اکتفا کردیم که
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  کاربران براحتی به مبانی آموزشی و ابزارهاي لازمه دسترسی داشته باشند،   :اول

  برطرف نماید، وتا حد قابل قبول نیاز آنان را   :دوم

  .متناسب با نیاز خود را بیابند و آنرا تکمیل کنند  ها روشی در حین این فعالیت  :سوم

  
توانند در این نشریه براي هر موضوع و حتی براي نکاتی که بطور تلویحی  کاربران می

 ایرادهـاي کنند تـا   این تمرینات کمک می. مطرح شدند، یک تمرین عملی طراحی کنند
هـر روش را مـورد ارزیـابی قـرار      ایرادهـاي پس از این مرحله، . هر روش را تجربه نمایند

  . دهند تا بتوانند بسته به نیاز خود، یک شیوه را انتخاب و آنرا ادامه دهند
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 هاي مفید سایت -11
 

 ehsimi.blogfa.com 

 eTrex owner’s manual for use. Garmin International Inc. 

 http://buy.garmin.com 

 http://my.garmin.com 

 http://software.garmin. 

 com/en-US/express.html  

 http://static.garmincdn.com/basecamp/4_2/en/Default.htm 

 http://www.garmin.com/aboutGPS 

 http://www.google.com/earth/download/ge/agree.html  

 http://www8.garmin.com/support/download_details.jsp?id=4435  

 https://my.garmin.com/mygarmin/customers/myGarminHome.faces  

 www.gpsinformation.net 

 www.gpsinformation.org 
 www.mapshop.ir 
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  واژه نامـه
 

 GIS  ArcGISیک نرم افزار در حوزه 

 Area calculation  یابی مساحت

 Bearing  زاویه سمت

 GIS  سامانه اطلاعات جغرافیایی

 GPS  جغرافیاییسامانه مکانیاب 
 GPS  GPS receiverگیرنده 

 Handheld GPS device  دستی جی پی اس

  Navigation  مسیریابی، راهبري

 Polygon  چند ضلعی] شکلِ[

 Record method  روش یادداشت برداري
 Recording interval  فاصله یادداشت برداري

 Route  مسیر، خط سیر
 Route planar طرّاح مسیر

 Surveying  مساحی
 Track  رد پا، اثر

 Waypoint  نقطه یا موقعیت
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